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Be sure to always read this user’s manual before using this product. 
Keep this manual in a safe, easily accessible place for future reference. 



To the Customer 
 

 
1. Follow all applicable laws and regulations in the capturing, image processing, interpretation, storage, and other 

handling of medical images. 
2. It is the responsibility of the customer to maintain confidentiality of image data. 
3. Canon shall bear no responsibility for any damage, direct or indirect, resulting from the use of this product. Also, 

Canon shall not provide any compensation for any image data that is lost due to any cause whatsoever. 
4. Read the license agreement of each software for the notes on handling the software that is going to be used with this 

product.  
5. The specifications and other information for this product are subject to change without notice. 
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Usage Precautions 
 

 
Be sure to always observe the following precautions. 
 

1. Never use general-purpose image retouching software to edit or overwrite the images files for the CR-DGi Image 
Viewer. The study information and image information written into the image file can be corrupted or become 
unreadable. 

2. Do not use the preview screen in Windows XP to rotate an image file for the CR-DGi Image Viewer. If an image is 
rotated, the study information and image information written into the image file can be corrupted or become 
unreadable. 

3. If the display is not set to full color, the colors may not be displayed properly. To set the display colors in Microsoft 
Windows, select Display Properties, go to Settings, and then check that the Colors is set to True Color (24 bit or 
32 bit). 

4. Use the CR-DGi Image Viewer in a system environment with the proper security protection. The CR-DGi Image 
Viewer itself does not have any security protection functions. 

5. In CR-DGi Image Viewer, the study information and image information are saved to the image in clear text.  
6. Be sure to always test beforehand to check that images are captured and saved properly. 
7. The user of the CR-DGi Image Viewer needs to belong to the member of the Power Users  group or the 

Administrators group. 
 
 
 

 
IMPORTANT 
Original images captured by the CR-DGi are reversed horizontally and vertically and do not have an 
aperture mask. 
Be sure to always use the CR-DGi Image Viewer to rotate the image 180 degrees and add an aperture 
mask to the image. 
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1. Introduction 
 

1.1 Overview 

This software package is a viewer application specifically for the Canon Non-Mydriatic Retinal Camera CR-DGi 
(called “CR-DGi” below). Retinal images captured from the EOS digital camera installed on the CR-DGi are 
automatically loaded, and special CR-DGi image processing is performed to display the images. If necessary, the 
study information is recorded together with the image and saved to a folder created for each capture date. 
 
 Images captured using the CR-DGi are automatically received and displayed.  
 Exif and RAW images can be captured. 
 Any size image set by the EOS digital camera can be captured.  
 Images can be saved in JPEG, BMP, and RAW formats. 
 Study information is saved inside the JPEG file.  
 Images can be magnified and reduced in size, and the brightness and contrast can be adjusted.  
 Images can be printed with the study information.  
 Images can be managed using dated folders. 
 Images can be managed by the counter number for each date. 
 Images can be compared. 

 

1.2 Operating Environment 

 OS:  Windows 2000 Professional or Windows XP Professional 
 CPU:  Pentium III 600 MHz or faster (Pentium 4 1.6 GHz or faster is recommended) 
 RAM:  256 MB or more (512 MB recommended) 
 Hard disk:  10 GB or more recommended 
 Monitor:  1024 x 768 dots or higher resolution, 24bit color or higher 
 CD-ROM drive Required for installation 
 Printer  Required if using the printing function 
 Digital camera EOS-D60/10D 
 Retinal camera CR-DGi 
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1.3 Image Management of the CR-DGi Image Viewer 

Images recorded by the CR-DGi Image Viewer are rotated 180 degrees, combined with an aperture mask, and then 
displayed on the monitor. When an image is saved, image information and study information are added to the 
appended information of the JPEG image, and the image is saved to a folder with the capture date. Under the 
standard settings, only JPEG images are saved, but it is also possible to save uncompressed image formats such as 
BMP and original images captured by the retinal camera in formats set by the digital camera. 
 

jpeg

Save folder

CR-DGi Image Viewer

Image processing
180 degree Add Mask

Study information
Image information

bmp

original

(Option)

(Option)

CR-DGi
 

  

Image processing 
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Format of saved files 
 
 CXXXXXXX.jpg 
This is the standard format for compressed image files that are saved. The file name is ‘C’ + a 7-digit number. This 
7-digit number is the same regardless of the format. This image file contains the following information. 
 Item Description 
1 Serial number This is the same number in the file name and cannot be changed by the user. 
2 Capture date and time This cannot be changed by the user. 

3 Counter number This is a four-digit number that counts up whenever an image is captured, and 
each day starts at 0001. 

4 Right/left eye This is designated at the panel. 
5 Image comments Up to 64 bytes of text can be entered. 

6 Note 1 This can be entered by the user from the panel. Up to 32 bytes of text can be 
entered. 

7 Note 2 This can be entered by the user from the panel. Up to 32 bytes of text can be 
entered. 

8 Note 3 This can be entered by the user from the panel. Up to 32 bytes of text can be 
entered. 

9 Note 4 This can be entered by the user from the panel. Up to 32 bytes of text can be 
entered. 

 
 BXXXXXXX.bmp 
This is an uncompressed image file. This format can be viewed from this software. Study information and image 
information are not recorded in this file. The file name begins with ‘B’ + 7-digit number. 
 
 RXXXXXXX.jpg /RXXXXXXX.crw 
These are original images captured by the digital camera. The file format is identical to the format set by the digital 
camera. The file name begins with ‘R’ + 7-digit number. 
Note: The original image does not undergo a 180-degree rotation or application of an aperture mask. The image 
cannot be displayed in the CR-DGi Image Viewer. 
 

1.4 Installation 
Log on to Windows as the Administrator or as a user who is a member of the Administrators group. 
Install the RemoteCapture and ZoomBrowser software supplied with the EOS digital camera. Perform 

installation by following the instructions on the screen. This process also installs the drivers for the digital 
camera. 

Install the CR-DGi Image Viewer. Perform installation by following the instructions on the screen. 

1.5 Uninstalling 
Log on to Windows as the Administrator or as a user who is a member of the Administrators group. 
Open Add/Remove Programs under the Control Panel. 
Select the CR-DGi Image Viewer, and then click the Change/Remove button to uninstall. 

1.6 Online Help 
Open DGi Image Viewer Help under the Help menu. 
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2. Preparation and Basic Operations 
 

2.1 Preparation 

Click the shortcut on the Desktop, or from the Start menu, select Programs > Canon CR-DGi Image 
Viewer > CR-DGi Image Viewer V1.00 to start the software. 

 
The main window of the software opens. 

 
 
Click the Setup button. The Setup dialog box opens. 
Select the Save tab. 

 
Select Date order. 
Insert a check mark for bmp if saving in an uncompressed image format. 
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2.2 Main Window 
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 Item Description 

1 Save button 
This is used when saving the captured image or saving corrected image 
information. 

2 Correct button This is used to correct the study information for a saved image. 

3 Print Preview button This displays the Print Preview screen for the selected image. 

4 Erase button This deletes the selected image. 

5 Setup button This opens the Setup dialog box. 

6 Adjust Image button This is used to adjust the image brightness and contrast. 

7 JPG button This displays the JPEG image. 

8 BMP button This displays the BMP image. 

9 Thumbnail image display area This displays the thumbnails of images saved in the date folder, and it 
displays the images before they are saved during capture. 

10 Counter number This displays the counter number. 
11 Capture time This displays the time that the image was captured. 

12  tab 
This switches to Capture mode. This is selected when capturing a 
retinal image. This displays the connection status for the Connect 
button and Release button. 

13 Date folder This is the folder for the date when the study was conducted. 

14  tab 
This switches to View mode. This is selected to view the images saved 
in the date folders. 

15 Main image display area This displays the image selected in the Thumbnail Image Display Area. 
16 Information display area This displays the study and image information. 
17 Study Information This displays the study information. 
18 Study Date This displays the study date. 
19 Note 1 This records and displays notes for the study. 
20 Note 2 This records and displays notes for the study. 
21 Note 3 This records and displays notes for the study. 
22 Note 4 This records and displays notes for the study. 
23 Image Information This displays the information for each image. 
24 File name This displays the file name. 
25 Date time This displays the capture date and time. 
26 Counter This displays the counter number. 

27 R/L eye 
This records and indicates the right or left eye. The right eye is 
indicated by R, the left eye by L, and undermined by O. The setting O is 
used if no setting is made. 

28 Comment This records comments for the image. 
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2.3 Connecting to the Digital Camera 
 
 Refer to the Retinal Camera Operation Manual for the attachment procedures for the retinal camera and 

digital camera. Load a CF card into the digital camera. 
 Use the supplied interface cable to connect the camera and PC. If the cable is not long enough, do not use a 

USB hub. Instead, obtain an extension cable. The maximum allowable length of the USB cable is 5 m. 
 Turn on the retinal camera. Do not switch the retinal camera to retinal image observation mode. 
 The standard settings for the digital camera (EOS D series) are shown in the table below. 
 

Setting Item Standard Setting 
Shooting mode Manual (M) 
Drive mode Off 
ISO speed 400 
Shutter speed 1/60 sec 
White balance Flash 
Auto power off OFF 
Quality (Recording size) User selected 
Quality (Compression ratio) User selected 

 
 Turn on the digital camera. 
 The Event on Device window opens. Click the Cancel button without selecting any registered applications. 

 
 Select the Capture tab of the CR-DGi Image Viewer, and then click the Connect button. 
 The connection was made properly if the connection status changes from “Not connected” to “Connected”. 
 

 
The connection cannot be made when pressing the Connect button if the retinal camera is in retinal image 
observation mode. Be sure to always click the Connect button from the eye front observation mode. 
In Windows XP, the Canon ZoomBrowser may start without opening the event window for the device when the 
digital camera is turned on. In this case, exit the Canon ZoomBrowser. 
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 To disable opening of the event window for the device:  
 
Windows 2000 
 Go to Start  Settings  Control Panel, and then open “Scanners and Cameras”. 
 Check that “EOS xxx” is selected, and then click the Properties button. 
 Open the Events tab in the EOS xxx Properties dialog box, insert a check mark for “Disable device events”, 

and then click the OK button. 

 
 
Windows XP 
 Go to Start  My Computer, and then right-click “EOS xxx” to open the Properties dialog box. 
 Open the Events tab in the EOS xxx Properties dialog box, select “Take no action” under the Actions section, 

and then click the OK button. 
 If there are multiple selections for the “Select an event” option, set “Take no Action” for all selections. 
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2.4 Basic Operations
 

2.4.1 Capturing and Saving 
To capture the retina, select the Capture tab. Check that the connection status is “Connected” before starting 
capture. When capture is started, the connection status changes to “Downloading…”, and the transfer of the 
captured image from the digital camera is started. When the transfer is complete, the captured image is displayed 

in the thumbnail display area and main image display area. Click the  button to save. Once the image is 
saved, it no longer appears on the screen. 

 
 
 



 

    10

2.4.2 Viewing 
Click the Folder tab. Select the folder with the capture date from the folder list. Thumbnails of images saved to 
the selected date folder are displayed in the order that the images were captured. Find the counter number of the 
image that you want to view, and then select the image to display it in the main image display area. 

 
 
2.4.3 Printing 
Images can be printed from either the Capture tab or Folder tab. Select the image to be printed, and then click the 

 button. Printing is performed in single pages. 
 

 
Clicking the Print button displays the Print dialog box. Select the printer to be used, set the printing paper, 
orientation, and other options in Properties, and then start printing. 



 

    11

3. Screen Operations 
 

3.1 Capture Mode and View Mode 
Capture mode is started when the  tab is selected. Select the Capture tab when capturing images. 

 
 
Select the  tab to start View mode. This is used to display saved images. 
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3.2 Thumbnail Window
 

 Thumbnails are displayed from left to right and top to bottom in the order that they were captured. 
 Left-click the mouse to select an image. The selected thumbnail is indicated with a blue frame. 
 The selected thumbnail image is displayed in the main image display area below the thumbnails. 
 Press the right arrow key to move the selected image to the right. Press the left arrow key to go back. 

Pressing the down key moves selection to the thumbnails in the lower row. Pressing the up key moves the 
selection to the thumbnails in the upper row. 

 Pressing the Home key moves the selection to the first image, and pressing the End key moves the selection 
to the last image. 

 Double-clicking the thumbnail opens a pop-up window. More than one pop-up window can be opened. 
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You can change the number of displayed thumbnails by moving the boundary up or down for the thumbnail 
image display area and main image display area. Enlarge the thumbnail display area when there are large 
numbers of thumbnails. 
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3.3 Main Window 
 

 This displays the selected thumbnail. 
 The size of the image in the main window is adjusted to the size of the display area. A larger image can be 

viewed if the display area is enlarged by adjusting the borders. 
 Pressing the + key enlarges the image, and pressing the – key reduces the image. 
 To view the image at its original size, select the Original size command from the View menu. To view the 

image so that it matches the main window, select the Fit image to window command under the View menu. 
 Double-clicking the image opens a pop-up window at the displayed zoom percentage. 

 

 
 

 



 

    15

3.4 Entering and Correcting Image Information 
 

3.4.1 Entering Image Information 
By entering the Study Information in Capture mode, the same information can be entered for all images 
captured at a single study. Image-specific information is entered from the R/L eye and Comment fields of 
Image Information. 
The example shows the recorded information when three images are captured in a single study, and the Study 
Information and Image Information are entered and saved. 
 

Information Field Image File 
File name C0000004.jpg C0000005.jpg C0000006.jpg 

Note 1 1000123 
Note 2 1-999-123 
Note 3 XYZ 

Study 
Information 

Note 4 M 
Counter  0001 0002 0003 
R/L eye R R L 

Image 
Information 

Comment ABCD EFGH IJKLMN 
 

Image Information 1

Study Information

Image Information 2

Image Information 3

 
 

Up to 32 characters can be entered in Notes 1 to 4. Up to 64 characters can be entered in the Comment. 
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3.4.2 Correcting Image Information 
Study information is corrected and added from View mode. 
 Select the date folder, and then select the image to be corrected. 

 Click the  button. The fields for Study Information and Image Information in the Information 
screen can be entered. 

 Correct or add the Study Information. 

 Click the  button. The fields for Study Information and Image Information in the Information 
screen are grayed out to indicate that corrections can no longer be performed. 

 To cancel the corrections, either press the ESC key, or select Undo from the Edit menu. 
 Corrections are cancelled if the date folder is moved while making the corrections. 
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3.5 Comparing Images (Pop-up Windows) 
 

Pop-up windows are used to compare images. Double-clicking the thumbnail window or main window opens 
a separate pop-up window. If comparing with a previous image, select another date folder, and then open a 
pop-up window for the image that you want to compare. When the zoom percentage of the main window is 
changed, the pop-up window is opened at that zoom percentage. The images in the pop-up windows cannot be 
printed or retouched. All pop-up windows are closed when exiting the DGi Image Viewer. 
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3.6 Adjusting Images 
 

The contrast and brightness of images can be adjusted. When an image is selected in the main window, the 
Adjust Image button  is enabled. Clicking this button opens the Adjust Image screen. Move the slide bar to 
adjust the brightness and contrast. The image can also be adjusted by directly entering the numerical value. 
The adjustable range is -10 to +10. Check the image, and then click the OK button to close the Adjust Image 
screen. Click the Cancel button to abort the image adjustment. 
 

 
 
The adjusted image is displayed in the main window. The image is still unsaved when displayed in this way, and 
so the adjusted image will return to its original state if you switch to another image. To save the adjusted image, 
select the Save retouched image command from the File menu.  
The original image is not overwritten when you adjust and save an image. All image information is maintained 
and saved as a new image. In the thumbnail window, the adjusted image can be identified by the same counter 
number. 

 
 

 
Images can be adjusted when the JPG button  is selected.
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3.7 Printing 
 

The image selected in the main window can be printed. An adjusted image in the main window can also be 
printed. Images cannot be printed at the zoom setting. 

Click the  button in the tool bar to open the Print Preview window. Clicking the Print button opens the 
Print dialog box. Select the printer to be used, set the printing paper, orientation, and other options in the 
Properties, and then start printing. The available options in Printer Properties vary depending on the selected 
printer. For more information, refer to the manual of the printer that you are using. 
The fields that can be printed are Note 1 to Note 4, R/L eye direction, and Capture date and Capture time.  For 
some paper sizes, it may not be possible to print all the information. 
 

 
 

 
3.8 Deleting Images 

 

Images can be deleted in Capture mode and View mode. Select the image, and then click the  button. A 
dialog box is opened. Click OK to delete the image. To abort the delete operation, click the Cancel button. 
If the save folder is set to the hard drive of the PC, deleted images are moved to the Recycle Bin. To restore 
images that were accidentally deleted, open the Recycle Bin, and restore the file. For details about this 
procedure, refer to Windows Help file. 
 

 
Deleted images cannot be restored if the save folder is shared over a network. Be sure to make backups on a 
regular basis. 
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3.9 Setup Dialog Box 
 

The Setup dialog box is used for making the settings for the save folder, selecting option for saving the image 

etc. Click the  button to open the Setup dialog box. 
 

 
Capture folder: This folder temporarily stores the digital camera images. The default setting is the Temp 

folder under the installation folder. 
Date and time setting from PC: This resets the clock in the digital camera to match the PC clock. 

 

 
Image processing: CR-DGi is selected, and this setting cannot be changed. 
Mask file: Mask file exclusive for the CR-DGi is selected, and this setting cannot be changed. 
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Save folder: This selects the save folder. Click the button at right end to select the save folder. In the default 

setting, a Save folder is created under the Installation folder. 
Image quality: This sets the image quality of JPEG files. The default setting is 96. The setting range is 80 to 

100. Larger values provide in higher image quality, but also result in larger image sizes. 
Image size: This selects the pixel size of JPEG files. The Original setting saves that image at the same size as 

the captured image. The 3072, 2160, and 1440 settings indicate the pixel width, and the aspect 
ratio of the image is not changed. The default setting is Original. 

Date order: This sets the format of the date folder. 
Save option: Although the image is saved as a JPEG file under the standard settings, when a checkmark is 

inserted in this option, the BMP file and the original file before image adjustment are saved at 
the same time. BMP files are saved as BXXXX.bmp, and original files are saved as 
RXXXX.crw(jpg). The “XXXX” portion is the same number as the JPEG file. 

Limit for displaying message: A warning will be displayed when the storage capacity of the disk where Save 
folder is stored becomes lower than the value set here. The default setting is 500(MB). 

 

 
Item1: This defines the “Note1” label in the Study Information. Up to 12 bytes of alphanumeric characters can 

be entered. In some system fonts, the character width is large, or some characters are not displayed. 
Therefore, be sure to check the displayed information at the Information screen. 

Item2: This defines the “Note2” label in the Study Information. 
Item3: This defines the “Note3” label in the Study Information. 
Item4: This defines the “Note4” label in the Study Information. 
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3.10 Menus 
 

 
File menu:  

Save: This stores unsaved images. 
Save retouched image: This saves retouched images. This does not overwrite the image. It is saved under a 

new file name. 
Print: This opens the Print dialog box. 
Print preview: This opens the Print Preview screen. 
Print setup: This opens the Printer Setup screen. 
Exit: This exits the application. 
 

Edit menu: 
 Undo: This deletes the last revision made for the study information. 
 Adjust image: This opens the Adjust Image screen. 
 Edit image information: This corrects the study information. 
 Delete: This deletes the selected image. 
 Setup: This displays the Setup dialog box. 
 
View menu: 
 Zoom in: This provides an enlarged view. 
 Zoom out: This provides a reduced view. The view cannot be reduced smaller than the size of the main 

window. 
 Fit image to window: This displays the main screen size to fit the main window. 
 Original size: This displays the image at the original image size. 
 JPEG: This displays a JPEG image. 
 BMP: This displays a BMP image. 
 
Help menu: 
 DGi Image Viewer help: This displays online help. 
 About DGi Image Viewer: This displays the version information. 
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3.11 List of Error Messages 
 

 

 
This is displayed when the designated save folder does not exist. If you click the Yes button, a Save folder is 
created under the installation directory of the software. 
 

 
This is displayed when the capture folder does not exist. If you click the Yes button, a Temp folder is created 
under the installation directory of the software. 
 

 
This indicates that the available hard disk space where the Save folder was set is less than the specified amount. 
Immediately move the images to obtain more disk space. 
 

 
This indicates that the available hard disk space where the Capture folder was set is less than the specified 
amount. Immediately move the images to obtain more disk space. 
 

 
This is displayed when there is an unsaved image. This is displayed when you capture images and try to exit 
without saving or try to exit the software while correcting the Study Information. Clicking the Yes button saves 
the image. 
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4. Other Operations 
 

4.1 Loading from a CF Card 
Recorded images may be stored in the CF card loaded in the digital camera without being transferred to the PC 
if images are recorded without connecting the digital camera to the CR-DGi Image Viewer or if some type of 
error terminates the software while the image is being recorded. This section shows the procedure for later 
loading the retinal images saved to the CF card to the CR-DGi Image Viewer. 
 

1. Set the main switch of the digital camera to OFF, and check that the access lamp is turned off. Open the 
CF card slot cover, and then press the Eject button to unload the CF card. 

2. Insert the card into a CF card reader connected to the PC. 
3. The PC recognizes the CF card as a removable disk. 
4. Open Explorer, and display the list of images in the CF card. 
5. Start the CR-DGi Image Viewer, select the Capture tab, and then switch to Capture mode. 
6. From Explorer, drag each retinal image in the order that it was captured to the thumbnail window or main 

window of the CR-DGi Image Viewer. If you drag more than one image at a time, the images will not be 
ordered according to their capture time. 

7. Enter the Study Information and Image Information if necessary. 

8. Click the  button to save. The images are put into the saved date folder. 
 

 
 

 
When ejecting the CF card from the CF card reader, open My Computer, and then right-click the icon for the 
CF card reader, and click Eject from the pop-up menu. Then, take the CF card out of the slot. 
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4.2 Backup and External Storage of Image Files 
 

Back up the image folders under the save folder on a regular basis. Possible methods of backing up are shown 
below. 
 
 Use Explorer to copy the folders to another hard disk. 
 Copy the save folder to CD-R, DVD, or other removable media. 
 Use the backup tools in Windows 2000/XP. 
 Use a commercial backup utility. 
 
When the amount of available space on the hard disk containing the save folder and capture folder becomes 
less than 500 MB, an alert is displayed when starting the software and when saving an image. In this case, you 
should immediately free space on your hard disk. Possible methods of freeing disk space are shown below. 
 
 Move old date folders that are not viewed in Explorer to another hard disk. 
 Copy old date folders that are not viewed to CD-R, DVD, or other removable media, and then delete from 

your hard disk. 
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